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Welcome
QuNeo is a 3D multi-touch pad controller.  QuNeo is a different species of pad controller for 
electronic musicians, DJs, VJs and DIY hackers. While it covers all of the functionality of 
other pad controllers, QuNeo adds the power of touch recognition in multiple dimensions.

Each of the 27 pads, sliders and rotary sensors are pressure, velocity, and location 
sensitive.  The 17 buttons also respond to pressure and velocity.  The 16 square pads 
provide 128 levels of velocity response, X-Y location, and continuous pressure for each pad.  
Each rotary sensor measures direction, pressure and location.

QuNeo is the size of an iPad and can fit in iPad accessories such as mic clips, stands and 
more.  QuNeo works with USB, MIDI or OSC and will communicate with your favorite music 
software environments right out of the box.

In this manual you will find detailed information to help answer all of your questions about 
QuNeo hardware and software.

Questions or Feedback? Contact Us!
If at any time you have any questions, please contact us:

Web: www.keithmcmillen.com
Forum: forum.keithmcmillen.com
Support: http://www.keithmcmillen.com/support

What's in the QuNeo Package

When you open up the box you should find:
● (1) QuNeo
● (1) USB A-to-Micro cable (1 meter)
● (1) QuNeo QuickStart Document
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QuNeo Software
Download our free QuNeo Software Installer from: http://www.keithmcmillen.com/QuNeo/
downloads/

The Software Installer contains template files that go with QuNeo presets for Ableton Live, 
Traktor, Battery, Reason, Mixxx, djay, and BeatMaker (iPad).  All of these can be 
automatically copied onto a computer by running the QuNeo Automatic Installer.  There is 
also a QuNeo Manual Installer, which will allow you to place the template files yourself.  
When using the manual installer, be sure to read the README files associated with each 
application template.

Automatic Installer Instructions (Mac and Windows XP & 7)
1 Double-click on the .dmg file to open the disk image, and then double-click on the 

QuNeo Software Installer.
2 Type the admin password for your computer and click ok (Mac).  Then click next.

3 Either choose a new directory where QuNeo will be installed 
or accept the default directory.  Click next.

4 Name the installation folder or accept the default.  Click 
Next.

5 On the “Select Components” page, select the software you 
want to use with QuNeo (as shown in the image to the 
right).  Click next.

6 If you checked any boxes for using QuNeo with other music software you will be 
prompted to check the installation directories to make sure they are correct.  If you 
are warned that your path is incorrect you must follow the instructions to go back 
and choose the correct path (otherwise there will be an installation error).

7 Finish up with the installer and a QuNeo folder will now appear in the Applications 
(Mac) or C: drive (Windows) directory on your computer.  Any Software Templates 
you selected will also be installed in the correct locations.

Manual Installer Instructions (Mac and Windows XP & 7)
To install the Manual Installer just unzip the file after downloading and move the whole 
folder anywhere.  If using any of the software templates, look inside the “Software 
Templates” folder and the folder for the desired software to find a README file and/or a 
Quickstart guide.  The README files contain instructions for manually placing the necessary 
template files.  The Quickstart guides contain instructions for getting QuNeo up and running 
with the software.

Now that the software is installed, look inside the QuNeo folder to find a “Documentation” 
folder, a “Software Templates” folder, and a “QuNeo Editor” folder.  Use the QuNeo Editor to 
make changes to QuNeo’s presets.  Template files for the software you selected will appear 
in the “Software Templates” folder.  To use them just plug in QuNeo, select the 
corresponding preset, and try out the template.  Use the Quickstart Guides in the respective 
Software Templates folders for more information about using these templates.

Once installed keep everything in the “QuNeo Editor” folder as is so the application can 
access everything it needs to run.
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System Requirements
We recommend the following minimum system requirements for the QuNeo Editor and the 
Software Examples:
MAC:

• An Intel Core 2 Duo 2.3GHz or 
greater 

• Mac OS 10.5 or later
• 100 MB free hard disk space

WINDOWS:
• Windows XP, or Windows 7
• Intel Core 2 processor or greater
• 1GB of RAM with 100 MB free hard disk 

space

Updating the Firmware
Make sure the editor and the firmware versions are compatible with each other.
When the QuNeo Editor opens, it checks to 
make sure the firmware on the device is 
compatible with the application.  If the 
firmware is not compatible, an update prompt 
will appear.  Click ok and wait until the blue 
Mode button light stops flashing and the 
“Update Complete” dialog appears before 
continuing.  The blue light and progress bar on 
screen indicate that the firmware update is in 
progress.

An “Update Firmware” option is located in the 
file menu of the QuNeo Editor.  Select this 
option and the prompt to the right will appear.  
Click ok to update firmware.

Keith McMillen Instruments cannot be held liable for damage resulting from 
installation and operation errors or improper use.

Updating Presets
To update your presets to the current version follow these steps:

1 Open up the previous version of the QuNeo Editor, where 
you made the presets you wish to use.

2 Export each preset using the File menu.
3 Exit the previous version of the QuNeo Editor and open up 

QuNeo 1.2.2.
4 Go to a factory preset you wish to import your old preset 

to.
5 Go to the File menu and select “Import Preset”
6 Locate your .quneopreset file and import it.
7 Save the preset and update your QuNeo.
8 Repeat steps 4-7 for any other presets you wish to update.

Tip:  When updating older presets to the new version, new parameters will be set to default 
values.  Be sure to check out the new features and make sure they are set up how you 
would want them.
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Main Window Overview
The QuNeo Editor opens with this window:

Selecting a sensor on the QuNeo image will open an edit pane in the box to the right.  In 
the edit pane, one can adjust the settings and MIDI data for the selected sensor.

In the bottom left side of the window is an indicator to show that QuNeo is connected to the 
Editor.  If the Editor has found the QuNeo, the device indicator will automatically change to 
“QuNeo 1” (after the application fully loads) to show that a connection between the Editor 
and QuNeo has been made.

Controls for saving and recalling presets are found in the bottom right side of the window.
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Saving
Select presets from the menu, name them in the text 
box, and save or revert them with the “Save Preset” 
and “Revert” buttons.  Press the “Update Preset” 
button to send the current preset to the QuNeo or press 
the “Update All” button to send all of the presets to the 
QuNeo.
If edits are made to the selected preset, the Save 
Preset button will begin to blink red as a reminder to 
save.  Click the save button to save the selected preset, 
and it will cease to blink red.  Modified/unsaved presets 
will appear in the preset list with an asterisk until they 
are saved.

Click the Revert button to go back to the previously 
saved state of the current preset.

In the menu, the presets are listed by number to correspond with the pad numbering when 
selecting presets from the QuNeo (see the Selecting Presets chapter of the Full Manual for 
more information).

Menu Bar
More functions can be accessed from the File menu.  “Save 
Preset” exists here as well as “Save All Presets”.  “Import 
Presets” opens previously exported presets into the currently 
selected preset slot.  “Export Presets” will save a file 
containing the currently selected preset for safe keeping or 
sharing.  “Export All Presets”  will save 16 files, 1 for each 
preset.  Importing and Exporting makes preset sharing easy.
The Edit menu contains copy and paste functions.  “Copy 
Current Preset” will put the current preset onto the 
application’s clipboard.  To paste a copied preset into a 
different preset, use the “Paste to Current Preset” option.  
It will then be necessary to save the pasted preset.

“Copy Sensor” places parameters from the current sensor’s 
edit pane on the clipboard.  Selecting another sensor of the 
same type enables the “Paste Sensor” option.

“Clear Current Preset” will blank out the current preset.  All sources will be off and 
everything else will be set to their default values, allowing the user to start from scratch.  
After clearing the current preset, it is necessary to save it.  “Revert Current Preset to 
Factory” reloads the original preset into the current preset slot.  “Revert All Presets to 
Factory” reloads all of the original presets.  After reverting to the factory presets, save to 
keep the factory versions.

“Edit Next Sensor” and “Edit Prev Sensor” allows the use of key commands to move to 
the next edit pane.
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The Drum Styles menu contains options that auto-adjust the Pad 
sensitivities and advanced parameters to create different “feels” 
when playing the pads.

The Hardware menu contains a couple options that will affect the 
QuNeo hardware.  The “Update Firmware...” option will open up a 
firmware update prompt.  Click ok and the firmware will update. 
(see the “Updating the Firmware” chapter of the Full Manual for 
more information).

The “Swap Pad LEDs” option will switch the red and green LEDs on the QuNeo.  Use 
“Program Change Out” and “Program Change In” to enable and disable program 
changing.  Enabling Program Change In causes Presets to change when sending a Program 
Change to QuNeo.  Enabling Program Change Out causes QuNeo to send Program Changes 
when a new Preset is selected.

Sensor Edit Panes

The image above shows Pad 13 selected on the QuNeo image and the Pad 13 edit pane 
open on the right side of the window.  Pad 13 is highlighted pink to show that it is selected.

When editing a parameter in the edit pane, the parameter is displayed on the QuNeo image; 
as are the similar parameters for all sensors.  Example:  In the image below, the Note 
parameter for Pad 13 is set to MIDI note 60 (C3).  All of the other pads will display their 
notes as well.  This allows easy checking to prevent unwanted duplicate notes.
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Adjusting the Pressure parameter changes the QuNeo image to display what CC# is 
assigned to pressure on all of the pads.

All parameters are displayed in this way for all sensor types.

To select multiple sensors to edit simultaneously, hold shift while clicking on another sensor.  
You can only do this with sensors of the same type.  For Example: If a Pad is selected you 
can shift-click another pad to edit them together (you cannot shift-click to edit a Pad with a 
Horizontal Slider or Rotary).

Read on for more detail about the editable parameters in each of the various edit panes.

Pad Edit Pane - Basic
Each Pad can function in either Drum Mode or Grid Mode.  In Drum Mode, it is not 
possible to edit the parameters for Grid Mode and vice-versa.  Enter Grid Mode by clicking 
the Grid tab and checking the “Grid Mode” check box.

In Drum Mode, the pad parameters include a note, pressure CC#, X-Axis position CC#, Y-
Axis position CC#, and X and Y Return values.  In Grid Mode, the pad sources include note 
and pressure for each corner, allowing up to 4 notes or pressure points per pad.

To disable a source, set the 
number box below 0 to 
“off” (-1).  X or Y can be set 
below off to “bend” (-2) in order 
to use pitch bend instead of a 
CC#.

Notes and Pressure CC#s can be 
set to Normal or Toggle mode 
and utilize Velocity/CC output 
number boxes for added 
functionality.  See the Normal 
and Toggle Modes chapter for 
more information.

X and Y Return values are the 
CC value that X and Y will return 
to when the Pad is released.  If 
the number box is set below 0 
the values will “latch” (-1), 
staying where they are left 
when the pad is released.

Global Sensitivity is at the very bottom of the edit pane.  For more information on this 
please reference the Sensitivity chapter.
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Pad Edit Pane - Advanced
There are 4 banks available for the notes of the Pads.  The note banks of the Pads can be 
selected by using either the Rhombus button, or one of the Up/Down button pairs.  This is 
programmable in the edit panes for those buttons.  See the Rhombus Button Edit Pane or 
the Up/Down Buttons Edit Pane chapters for more information.

The Pad notes for each bank can be adjusted here in the 
Advanced tab of the Pad edit pane.  Here you would set 
transpose intervals for the notes in each bank (as shown in the 
image to the right).  Take note that Bank 1 Transpose Offset is 
set to 0 so that bank 1 will not offset the notes programmed in 
the basic tab. Changing Pad banks will not affect the CCs of 
the other Pad sources (X, Y, Pressure, etc.).

Located in the bottom of the Advanced tab is the Corner 
Isolation parameter.  This parameter adjusts how sensitive 
the other corners of a Pad are while one of the corners is in 
use.  This helps prevent accidental triggers.  This is global for 
all Pads and applies only when they are in grid mode.  
Example: If corner isolation is set to 100, while pressing 1 
corner, the other 3 corners must reach 100% of the pressure 
the first corner is at before registering a note on.  The higher 
the corner isolation value, the greater the isolation is between 
corners.

Pad [#] Sensitivity Adjust - The higher the sensitivity, the easier it will be to get pressure 
and velocity to the higher value ranges.  The lower the sensitivity, the more difficult or 
impossible it will be to get the pressure and velocity to the higher value ranges.  This 
sensitivity setting is per Pad, which makes it easy to set each pad to a specific sensitivity.  
Use Global Sensitivity to tweak the sensitivity of all Pads simultaneously.

On Thresh - The pressure value at which a note on will register.  Example: If set to 10, 
the Pad pressure has to reach a value of 10 before a note on is sent.  This is global for all 
Pads.

Off Thresh - The pressure value at which a note off will register.  Example: If set to to 5, 
the Pad pressure would have to be 5 or lower for a note off to register.  This cannot be set 
higher than the on threshold.  This is global for all Pads.

Velocity Tables - When using the editor, there are five velocity tables.  These tables shape 
the velocity output of the QuNeo.

1 None - This table is linear and has no effect on the velocity output.
2 Medium - This table gives the most precision in the 0-100 velocity range.  As long 

as the sensitivities aren’t set low, hitting the Pads at Medium strength will give you 
access to the higher velocity values.

3 Light - This table emphasizes the mid range.  Light taps reliably give a range of 
50-100 but it is still necessary to hit harder to get to 127.

4 Hard - This table expands the lower range and makes it more difficult to hit the 
higher velocity values.

Dynamic - This table is good for getting varied velocity values with very little change in 
pressure.
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Playing Styles
The Pad’s global sensitivity and advanced parameters allow users to fine tune the playing 
style of their QuNeo.  Default values have been carefully chosen but we have also put 
together a few suggestions to accommodate other playing styles:

● For the user who wants to hit very hard to reach a velocity of 127 - try setting the 
velocity table to “Hard” and the global sensitivity dial down to 11 o’clock.

● For the user who wants high or low values, with very little middle range - try using 
the “Hard” or “Medium” velocity table with the global sensitivity dial at 12 o’clock.

● For the user who wants to tap very lightly and still get lots of dynamic range - try 
turning the on threshold up to 20 and the off threshold to 15.  Set the global 
sensitivity dial to just past 12 o’clock and select the “Dynamic” or “Light” velocity 
table.

Pad Edit Pane - LEDs

The LED tab of the Pad edit pane allows you to choose 
individual LED channels for Drum mode and both of Grid 
mode’s LED behaviors.

Drum Mode LED behavior - Pads can receive a note for the 
green LEDs and a note for the red LEDs.  The velocity of 
the note will determine the brightness.

Grid Mode LED behavior (individual notes) - The LEDs in 
each corner of the pad can light up individually.  Pads can 
receive 4 notes (one for each corner) for the green LEDs 
and 4 other notes for the red LEDs.  The velocity of the 
note will determine the brightness.

Grid Mode LED behavior (1 note per corner) - It is also 
possible to use 1 note per corner.  In this case the velocity 
of the note will fade the LEDs from green to red.

The input Channels for these LED behaviors are adjustable 
(as shown in the image to the right).  For a map of the 
hard coded notes and CC#s that control the LEDs, see the 
MIDI Input chapter of the Full Manual.

There is a Local LED Control check box at the very bottom of the edit pane.  For more 
information on this please reference the Local LED Control chapter.
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Vertical and Horizontal Slider Edit Pane
The Vertical and Horizontal Slider Edit Panes have essentially the same editable parameters.

There are 4 banks available per slider.  The Horizontal 
Sliders each have their own Left/Right Buttons to control 
which bank is selected.  See the Left/Right Buttons Edit 
Pane chapter for more information.

The banks of the Vertical Sliders can be selected by using 
either the Rhombus button, or one of the Up/Down button 
pairs.  This is programmable in the edit panes for those 
buttons.  See the Rhombus Button Edit Pane or the Up/
Down Buttons Edit Pane chapters for more information.

The Slider Edit Pane parameters include a Note, Pressure 
CC#, and Location CC# for each bank.  To disable a source, 
set the number box below 0 to “off” (-1).

Notes and Pressure CC#s can be set to Normal or Toggle 
mode and utilize Velocity/CC output number boxes for 
added functionality.  See the Normal and Toggle Modes 
chapter for more information.

Sensitivity can be adjusted at the very bottom of the edit 
pane (see the Sensitivity chapter).

For information about the Advanced and LEDs tab, reference the Advanced Tab (Sliders) 
chapter and the LEDs Tab chapter.

Long Slider Edit Pane
There are 4 Long Slider banks available.  They can be 
selected by using either the Rhombus button, or one of the 
Up/Down button pairs.  This is programmable in the edit 
panes for those buttons.  See the Rhombus Button Edit 
Pane or the Up/Down Buttons Edit Pane chapters for more 
information.

The Long Slider Edit Pane parameters include a Note, 
Pressure CC#, Location CC#, and Width CC# for each bank.  
To disable a source, set the number box below 0 to 
“off” (-1).

Notes and Pressure CC#s can be set to Normal or Toggle 
mode and utilize Velocity/CC output number boxes for 
added functionality.  See the Normal and Toggle Modes 
chapter for more information.

Sensitivity can be adjusted at the very bottom of the edit 
pane (see the Sensitivity chapter).

For information about the Advanced and LEDs tab, 
reference the Advanced Tab (Sliders) chapter and the LEDs 
Tab chapter.
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Advanced Tab (Sliders)

The Horizontal, Vertical, and Long Sliders all have the same 
Advanced tab.  There isn’t much in here just yet except for On 
and Off threshold adjustment parameters.

On Thresh - The pressure value at which a note on will register.  
Example: If set to 10, the Slider pressure has to reach a value 
of 10 before a note on is sent.

Off Thresh - The pressure value at which a note off will 
register.  Example: If set to 5, the Slider pressure would have 
to be 5 or lower for a note off to register.  This cannot be set 
higher than the on threshold.

These two parameters are global for their respective slider 
types.

Rotary Edit Pane
There are 4 Rotary banks available.  They can be 
selected by either the Rhombus button, or one of the 
Up/Down button pairs.  This is programmable in the edit 
panes for those buttons.  See the Rhombus Button Edit 
Pane or the Up/Down Buttons Edit Pane chapters for 
more information.

The Rotary Edit Pane parameters in the Basic tab include 
a Note, Pressure CC#, Location CC#, and Direction 
CC#, for each bank.  To disable a source, set the 
number box below 0 to “off” (-1).

Notes and Pressure CC#s can be set to Normal or Toggle 
mode and utilize Velocity/CC output number boxes for 
added functionality.  See the Normal and Toggle Modes 
chapter for more information.

The Direction CC# will repeatedly send out a 1 if finger 
movement is clockwise.  If finger movement is 
counterclockwise, the CC# will repeatedly send out a 
127.  We refer to this repeated CC# as a tick.  The 
faster a finger is moved, the faster the ticks will output.

Direction and Location cannot be used at the same time.  
Use the checkbox next to Direction to enable one or the 
other.

Sensitivity can be adjusted at the very bottom of the edit pane (see the Sensitivity chapter).

14



The Advanced tab of the Rotary edit pane contains a few more useful features.
The Pass Thru Width parameter works in conjunction with 
the Location parameter (editable in the Basic tab).  A 
variation of what is often called Pass Thru Mode is used 
when the location parameter is enabled.  Normally, in pass 
through mode, MIDI will not be sent until one passes 
through the value that the rotary was left at.  Pass Thru 
Width sets a range of pass through values.  Example:  If 
Pass Thru Width is set to 10 and the rotary was left at 40, 
it would be necessary to press somewhere between 30 and 
50 to pick back up and output location data.  If set to 127, 
the whole range of the rotary will respond.

The Speed parameter works in conjunction with the 
Direction parameter (editable in the Basic tab).  The 
Direction CC# will repeatedly send out a 1 if finger 
movement is clockwise.  If finger movement is 
counterclockwise, the CC# will repeatedly send out a 127.  
We refer to this repeated CC# as a tick.  The faster a 
finger is moved, the faster the ticks will output.  Speed 
controls the number of direction ticks per degree of the 
rotary.

The on and off thresholds can also be adjusted in the Advanced tab.  These are global for 
both Rotaries.

On Thresh - The pressure value at which a note on will register.  Example: If set to 10, 
the Rotary pressure has to reach a value of 10 before a note on is sent.

Off Thresh - The pressure value at which a note off will register.  Example: If set to 5, the 
Rotary pressure would have to be 5 or lower for a note off to register.  This cannot be set 
higher than the on threshold.

For information about the LEDs tab for the Rotaries, reference the LEDs Tab chapter.
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Transport Edit Pane

The Transport buttons are the 3 buttons at the top of the 
QuNeo next to the Mode button.  The diamond button with 
the red LED is the record button, the square button with the 
yellow LED is the stop button, and the triangular button 
with the green LED is the play button.

Assign the Channel, Note, and Pressure CC# for each 
Transport button in the Basic tab.  To disable a source, set 
the number box below 0 to “off” (-1).

Notes and Pressure CC#s can be set to Normal or Toggle 
mode and utilize Velocity/CC output number boxes for 
added functionality.  See the Normal and Toggle Modes 
chapter for more information.

Sensitivity can be adjusted at the very bottom of the edit 
pane (see the Sensitivity chapter).

The Transport buttons do not have Advanced tabs.  For 
information about the LEDs tab, reference the LEDs Tab 
chapter.

Left/Right Buttons Edit Pane

The Left/Right buttons are positioned to the left of each 
Horizontal slider.  If the “Enable Bank Switching” box is 
checked, these button pairs act as bank controls for each 
Horizontal Slider.  See the Vertical and Horizontal Slider Edit 
Pane chapter for more info.  The banks will be indicated by 
the LEDs of the 2 buttons.

For information about how the LEDs indicate the banks, see 
the Banks chapter of the Full Manual.

If Bank Switching is disabled, each button can output an 
assigned Note or Pressure CC#.  To disable a source, set the 
number box below 0 to “off” (-1).

Notes and Pressure CC#s can be set to Normal or Toggle 
mode and utilize Velocity/CC output number boxes for added 
functionality.  See the Normal and Toggle Modes chapter for 
more information.

Sensitivity can be adjusted at the very bottom of the edit 
pane (see the Sensitivity chapter).

The Left/Right buttons do not have Advanced tabs.  For information about the LEDs tab, 
reference the LEDs Tab chapter.
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Up/Down Button Edit Pane
The Up/Down buttons are positioned on either side of the 
Long Slider.  If the “Enable Bank Switching” box is 
checked, these button pairs act as bank controls for the 
Rotaries, Vertical Sliders, Long Slider, or Pad notes.  See the 
Vertical and Horizontal Slider Edit Pane, Long Slider Edit 
Pane, Rotary Edit Pane, or Pad Edit Pane - Advanced 
chapters for more info.  The banks will be indicated by the 
LEDs of the 2 buttons.

For information about how the LEDs indicate the banks, see 
the Banks chapter of the Full Manual.

If Bank Switching is disabled, each button can output an 
assigned Note or Pressure CC#.  To disable a source, set the 
number box below 0 to “off” (-1).

Notes and Pressure CC#s can be set to Normal or Toggle 
mode and utilize Velocity/CC output number boxes for 
added functionality.  See the Normal and Toggle Modes 
chapter for more information.

Sensitivity can be adjusted at the very bottom of the edit 
pane (see the Sensitivity chapter).

The Up/Down buttons do not have Advanced tabs.  For information about the LEDs tab, 
reference the LEDs Tab chapter.

Rhombus Button Edit Pane
The Rhombus button is positioned under the Rotaries and 
above the Vertical Sliders.  If the “Enable Bank 
Switching” box is checked, this button acts as a bank 
control for the Rotaries, Vertical Sliders, Long Slider or Pad 
notes.  See the Vertical and Horizontal Slider Edit Pane, 
Long Slider Edit Pane, Rotary Edit Pane, or Pad Edit Pane - 
Advanced chapters for more info.  The banks will be 
indicated by the LEDs of the button.

For information about how the LEDs indicate the banks, see 
the Banks chapter of the Full Manual.

If Bank Switching is disabled, the button can output an 
assigned Note or Pressure CC#.  To disable a source, set the 
number box below 0 to “off” (-1).

Notes and Pressure CC#s can be set to Normal or Toggle 
mode and utilize Velocity/CC output number boxes for 
added functionality.  See the Normal and Toggle Modes 
chapter for more information.

Sensitivity can be adjusted at the very bottom of the edit 
pane (see the Sensitivity chapter).

The Rhombus button does not have an Advanced tab.  For information about the LEDs tab, 
reference the LEDs Tab chapter.
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Normal and Toggle Modes
All sensors now utilize a drop down menu that selects Normal or Toggle mode for the note 
and pressure sources.

To the right of the menu are “Vel/CC Output” number boxes 
where you can specify the velocity and CC value output for 
the note and pressure CC#.

Here are some examples for how these can be used:

● To get notes with velocity and CCs with continuous pressure behavior, set the drop 
down menu to “Normal” and set the “Vel/CC output” boxes to “var” (variable) and 
“con” (continuous).  “Var” and “con” appear in the number box in place of 0.

● Normal mode can also be used to get notes and pressure to output like momentary 
switches.  The “Vel/CC output” boxes can be set to a value which will output when 
you press down and go back to 0 when you let go.

● In Toggle mode the “Vel/CC output” boxes set a value for the note or CC# to toggle 
on to (always toggles off to 0).

● Set the “Vel/CC output” boxes to “var” (variable) or “con” (continuous) while in 
Toggle mode to make the “on” toggle output variable velocity (for notes) or the initial 
pressure value (for pressure CC#s).  “Var” and “con” appear in the number box in 
place of 0.

Sensitivity
To edit the sensitivity of the various sensors, use the sensitivity dial at the bottom of each 
of the edit panes.  Sensitivity controls how easy it is to get higher value ranges when 
controlling pressure and velocity.  The higher the sensitivity, the easier it will be to reach the  
upper range of values.  The lower the sensitivity, the more difficult or impossible it will be to 
get higher value ranges.

The sensitivity dial in the Pad Edit Pane is called Global Sensitivity.  This differentiates it 
from the Pad [#] Sensitivity Adjust parameter, visible from the Advanced tab.

The Sensitivity dials are global for all controls of that sensor type.

Example:  Adjusting the sensitivity in one of the Pad Edit Panes will adjust the sensitivity 
for all pads.  The Sensitivity dials for the Horizontal Sliders are linked, the Vertical Sliders, 
the Left/Right Buttons, etc...
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LEDs Tab

The Slider, Rotary, and Button edit panes all use essentially the 
same LEDs tab.

You can adjust each sensor type’s LED channel.  All of the 
Factory Presets default to 1 as the LED channel for Pads in 
drum mode and all other sensor types.

This parameter is global per sensor type so if editing the LED 
channel in a Horizontal Slider edit pane, all of the Horizontal 
Sliders will change to the same channel.

The LEDs tabs also contain a checkbox at the bottom called Local LED Control.

Local LED Control
The QuNeo’s LEDs will automatically respond to touch without having to receive LED 
messages from another device.  Unchecking the Local LED Control check box can disable 
this built-in LED behavior.

Hint: If Local LED Control is disabled and the QuNeo is not receiving MIDI notes for 
controlling LEDs, the QuNeo will not light up at all.

In the Left/Right, Up/Down, and Rhombus Button edit panes, if Bank Switching is enabled, 
Local LED Control cannot be disabled.

The Local LED Control check box is global for all controls of that type.

Example:  Changing the Local LED Control in one of the Pad Edit Panes will change it for all 
Pad edit panes.  The Local LED Control check boxes for the Horizontal Sliders are linked, the 
Vertical Sliders, the Left/Right Buttons, etc.

If you experience any problems or have questions regarding the QuNeo install process 
submit a support request (http://www.keithmcmillen.com/support) outlining the problems 
you're experiencing.  The more detailed you are in describing your problem (information 
about your computer, the software you're running, the circumstances around the issue), the 
more easily we will be able to help you.
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